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Upcoming topics

Wed, Nov 4™ — MIPS Basic Architecture (Part 1)

Mon, Nov 9 — MIPS Basic Architecture (Part 2)

Wed, Nov 11" — No Class (Holiday)

Mon, Nov 16" — Computing Performance

Wed, Nov 18" — MIPS Pipelining and Hazards (Part 1)
Mon, Nov 23" — MIPS Pipelining and Hazards (Part 2)
Mon, Nov 30" — Memory and Caches (Part 1)

Wed, Dec 2" — Memory and Caches (Part 2)



Today’s Topics

* Beginning to build a MIPS datapath

— Single cycle datapath implementation
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The Processor: Datapath & Control

We're ready to look at an implementation of the MIPS

Simplified to contain only:

— memory-reference instructions: lw, sw

— arithmetic-logical instructions: add, sub, and, or, slt
— control flow instructions: beq, j

Generic implementation:

— use the program counter (PC) to supply
the instruction address and fetch the
instruction from memory (and update the PC)

— decode the instruction (and read registers)
— execute the instruction
All instructions (except j) use the ALU after reading the
registers

Why? memory-reference? arithmetic? control flow?
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Abstract Implementation View

* Two types of functional units:

— elements that operate on data values (combinational)
— elements that contain state (sequential)

Instruction »Write Data » Address
Memory Register ¢ad >
»Reg Addr Datd) Data
PC—>|Address  Instructior File > AL Memory Read Data

»Reg Addr
Read »\Write Data
Data

»Reg Addr

« Single cycle operation

* Split memory (Harvard) model - one memory for
instructions and one for data
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Fetching Instructions

* Fetching instructions involves

— reading the instruction from the Instruction Memory
— updating the PC to hold the address of the next instruction

\ 4

> Ad

Instruction
Memory

Read
" |Address

v
U
y

INStructiorfjm—p

— PC 1s updated every cycle, so it does not need an explicit write
control signal

— Instruction Memory i1s read every cycle, so it doesn’t need an
explicit read control signal
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Decoding Instructions

* Decoding instructions involves

— sending the fetched instruction’s opcode and function
field bits to the control unit

.| Control
Unit
» Read Addr 1
Register Dlzfaa? I
Instruction »Read Addr 2
File
Write Addr Read
) Data 2
Write Data

— reading two values from the Register File
» Register File addresses are contained in the instruction
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Executing R Format Operations

* R format operations (add, sub, slt, and, or)
10 5 0

R-type:

25 20

15

Irs Irt Ird |

shamt] funct

— perform the indicated (by op and funct) operation on values in rs and rt

store the result back into the Register File (into location rd)
ALU control

Instruction

RegWrite

l

\ 4

\ 4

\ 4

v

Read Addr 1

. Read
Register
Read Addr 2 Data 1
File

Write Addr Read

v

o
DAL

— overflow
— Zero

Data 2

Write Data

v

e

— Note that Register File is not written every cycle (e.g. sw), so we need an
explicit write control signal for the Register File
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Executing Load and Store Operations

* Load and store operations
31 25 20 15 0

I-Type: | op I"s Irt | address offset

— compute a memory address by adding the base register
(in rs) to the 16-bit signed offset field in the instruction
* base register was read from the Register File during decode
« offset value in the low order 16 bits of the instruction must be
sign extended to create a 32-bit signed value
— store value, read from the Register File during decode,
must be written to the Data Memory

— load value, read from the Data Memory, must be stored
in the Register File
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Executing Load and Store Operations, con’t

RegWrite ALU control MemWrite
l overflow l
»Read Addr 1 Zero
Register Dgfaa? — —)p —pAddress
Instruction >Read A::fjlr 2 > Data
ile Memory Read Datap——
YY" ALU ry
»\\Vrite Addr Read
Data 2— =—> —p\\Vrite Data
—p\\/rite Data
MemRead
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Executing Branch Operations

* Branch operations have to
31 25 20 15 0

I-Type: | op rs Irt | address offset

— compare the operands read from the Register File during
decode (rs and rt values) for equality (zero ALU

output)

— compute the branch target address by adding the
updated PC to the sign extended16-bit signed offset
field 1n the 1nstruction

* “base register” is the updated PC

o offset value in the low order 16 bits of the instruction must be
sign extended to create a 32-bit signed value and then shifted
left 2 bits to turn it into a word address
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Executing Branch Operations, con’t

Ad > Branch
4 —p ) >Ad target
address
ALU control
»PC
»IRead Addr 1 zero (to branch
Register Read|  _ control logic)

Read Addr 2 Data 1

File >
. ALU
Write Addr Read

Data 2— =—»

\ 4

Instruction

Write Data

16 0 32
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Executing Jump Operations

« Jump operations have to

J-Type:

jump target address

— replace the lower 28 bits of the PC with the lower 26 bits of the
fetched instruction shifted left by 2 bits

v

Ad

4 —p

"|Address

Instruction
Memory

Read

Instruction

Jump
address
28

David Brooks — CS141



Our Simple Control Structure

 We wait for everything to settle down

— ALU might not produce “right answer” right away

— we use write signals along with the clock edge to determine when to
write (to the Register File and the Data Memory)

* Cycle time determined by length of the longest path

We are ignoring some details like register setup and hold times
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Creating a Single Datapath from the Parts

« Assemble the datapath segments, add control lines as
needed, and design the control path

 Fetch, decode and execute each instructions in one clock
cycle — single cycle design
— no datapath resource can be used more than once per instruction, so

some must be duplicated (e.g., why we have a separate Instruction
Memory and Data Memory)

— to share datapath elements between two different instruction classes
will need multiplexors at the input of the shared elements with
control lines to do the selection

* C(Cycle time 1s determined by length of the longest path
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Fetch, R, and Memory Access Portions

v

v

PAd RegWrite ALU control MemWrite
= | ovf |
Read Addr 1 230
. »Rea r
Instruction . Read » Address
Memory Register
»Read Addr 2 Data 1 Data
:iggsess Instructior _ File — Memory Read Data
»(\Write Addr Read
Data 2 ' Write Data
Write Data —>
_ MemRead
\ Sign

\16 Extend 32
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Multiplexor Insertion

v

PAd RegWrite ALUSrc ALU control MemWrite MemtoReg

v

4 —p
l lovf l
Zero
Instruction »Read Addr 1
i Read » Address
Memory Register
»Read Addr2 Data 1 Dot
Read : )
> Instructiorn File v — Memory Read Datap—»
Address Az ry
»\\Vrite Addr Read
Write Data 222 2 Write Data
»Write Data
Si MemRead
\ ign
‘16 | Extend| “55
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Clock Distribution

System Clock

clock cycle

v

\ RegWrite MemWrite

v

@ ALUSrc ALU control MemtoReg
4 —p
ovf
Read Addr 1 l 230
. »Rea r
Instruction . Read »Address
Memory Reglster
»Read Addr2 Data 1 Dat
»|Read Instructior File M iy Read Datap—p
“|Address e \ = emory >
»\\Vrite Addr Read
Data 2 Write Data
h[Write Data
_ MemRead
\ Sign
\16 Extend 32
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Adding the Branch Portion

v

\ 4

\ 4

{2

v

Instruction
Memory

Read

=

Instructior
Address

RegWrite
» Read Addr 1
. Read
Register
»Read Addr 2 Data 1
File
»\\Vrite Addr Read
) Data 2
h[erte Data

ALUSrc ALU control

\Ad

PCSrc
MemWrite

lovf l

Zero

MemtoReg

Address

v

Data
- Memory Read Data

v

\Write Data

HG@ '32

T

MemRead
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Adding the Control

Selecting the operations to perform (ALU, Register File and Memory

read/write)
Controlling the flow of data (multiplexor inputs)

Information comes from the 32 bits of the instruction

31 25 20 15 10 5 0

Observations R-type: op Irs |rt |rd |sham funct

— op field always
in bits 31-26 31 25 20 15

— addroftwo  |-Type: op Irs | ri | address offset

registers to be
read are always specified by the
rs and rt fields (bits 25-21 and 20-16)

— addr. of register to be written is in one of two places — in rt (bits 20-
16) for Iw; in rd (bits 15-11) for R-type instructions

— Dbase register for Iw and sw always in rs (bits 25-21)
— offset for beq, Iw, and sw always in bits 15-0
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(Almost) Complete Single Cycle Datapath

v

»

o
L

>Ad
4 :)

\ 4

Instruction
Memory

Read Instr[31-0

" |Address

RegDst RegWrite ALUSTrc
Instr[25:213 Read Addr 1
. Read
INStr20M6} |5 g o " Data 1
L,“o File
L Write Addr Read
Instr{T Data 2
»\\rite Data

1]

Instr(15-0]

v
o

1

PCSrc
MemWrite MemtoReg

l

—ptAddress

Data
Memory Read Data

v

Write Data 0

\16@ '32

Instr[5-01

T

MemRead

ALUOp
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ALU Control

0 ALU's operation based on instruction type and function
code

ALU control input Function
000 and
001 or
010 add
110 subtract
111 set on less than

a Why is the code for subtract 110 and not 0117
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ALU Control, Con’t

e Controlling the ALU makes use of multiple levels of decoding
— main control unit generates the ALUOp bits
— ALU control unit generates ALU control inputs

Instr op funct | ALUOp | desired ALU control
action input

Iw XXXXXX 00

SW XXXXXX 00

beq XXXXXX 01

add 100000 10 add 010
subt 100010 10 subtract 110

and 100100 10 and 000

or 100101 10 or 001

slt 101010 10 slt 111
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ALU Control Truth Table

F5 | F4 | F3 | F2 | F1 | FO | ALUOpl | ALUOpO | Op2 | Opl | Op0
X | X|X|X|X|X 0 0 0 1 0
X | X|X|X|X|X 1 1 1 0
X[ X]{0[0]0]O0 | 0 | 0
X|X[0]0]1]0 1 1 1 0
X[ X[0]1T]01]O0 | 0 0 0
X[ X110 1T]0]|1 | 0 0 |
X[ X|[1]10]11]0 | 1 1 1

e (Can make use of more don’t cares

— since ALUOp does not use the encoding 11

— since F5 and F4 are always 10

* Logic comes from the K-maps ...
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ALU Control Combinational Logic

* From the truth table can design the ALU Control logic

ALD
A

AL

David Brooks — CS141



(Almost) Complete Datapath with Control Unit

v

) Ad ,
\Ad
4 —p
PCSrc
AL
B h
ranc MemRead
Instr[B1-26] Control MemioReg
Unit Memwvrite
\/ ALUSrc
RegWrite
RegDst
ovf
\ 4 \ 4
. Ilnstr{25:21LIRead Addr 1
Instruction Register Read —pAddress
Memory llnstr[20:16] Read Addr 2 Data 1 zZero Data
Read .
> Instr[31-0}=- File Read Dataf—p
Address ns r[3 0 Write Addr ALU Memory
1 Rea 0 Write Dat
linstr1 , Data 2 rite Lata
Write Dat
] —i[ rite Data ]
wsh o)
' X Extend X ALU
16 U 32 contro
Instr[5-0]
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Main Control Unit

Instr

RegDst

ALUSrc

MemReg

RegWr

MemRd

MemWr

Branch

ALUOp1

ALUOp2

R-type
000000

Iw
100011

SwW
101011

beq
000100

0 Completely determined by the instruction opcode field

e Note that a multiplexor whose control input is O has a definite
action, even if it is not used in performing the operation
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|-

R-type Instruction Data/Control Flow

v

\ 4

>Ad >
\Ad
4 —p
PCSrc
ALUQ Branch
MemRead
Instr[B1-2g] Control MemioReg
Unit MemWrite
\/ ALUSrc
RegWrite
RegDst
ovf
Y Y
. Jnstrl25:21)iRead Addr 1
'"“7::::'0" Register €40 —>Address
ry linstr[20+16}|Reaq Addr 2 Data 1 Data
Read i
> Instr[31-0]= File Read Dataf=—
Address 910 ° Write Addr Rea ALU Memory FERETH
1 .
Write Data
linstr1 . Data 2
Write Dat
] —-[ rite Data _
linstr(15-9 ] 3" ALU
16 U 32 contro
Instr[5-0]
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R-type Instruction Data/Control Flow

A\ 4

_ /
» KO
Ad >
S Add—»|1
4 —p
PCSrc
AL
B h
ranc MemRead
Instr[B1-26] Control MemioReg
Unit MemWrite
\/ ALUSrc
RegWrite
RegDst
(N oyf |
Instruction instrf2o:21] Read AM
M Register Read —pAddress
emory lInstr[20+16} |Read Addr 2 Data 1 zero Data
Read ] .
= Instr[31-0]=- 0 File Read Dataf—p
Address ns r[ | Write Addr ALU Memory
Rea 0
Write Data
{Instr| , Data 2
Write Dat
1] —i[ rite Data ]
Unstr[15-0] \ @ \ ALU
\16 @ \32 contro
Instr[5-0]
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Store Word Instruction Data/Control Flow

\ 4

v

) Ad ,
\Ad
4 —p
PCSrc
AL Branch
MemRead
Instr[B1-26] Control MemioReg
Unit Memwvrite
\/ ALUSrc
RegWrite
RegDst
ovf
\ 4 \ 4
. IInstr25:210IRead Addr 1
Inl\s,;Itructlon Register Read —pAddress
emory lnstr(20+16}|Read Addr 2 Data 1 zero Dat
Read . ata
> Instr[31-0f=m File Read Dat >
Address "1 Write Addr ALU Memory Teac =aia
1 Rea 0 Write Dat
linstr1 , Data 2 rite Lata
Write Dat
] —-[ rite Data ]
wsh o)
' X Extend X ALU
16 U 32 contro
Instr[5-0]
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Store Word Instruction Data/Control Flow

A\ 4

: {
Ad >
\Ad
4 —p
PCSrc
AL
B h
ranc MemRead
Instr[B1-26] Control MemioReg
Unit MemWrite
\/ ALUSrc
RegWrite
RegDst
! oyf /N
. Instr{25:21}|Read Addr 1
Instruction Register Read —pAddress
Memory Instr[20L16}|Read Addr 2 Data 1 zero Data
Read .
= Instr[31-0]=- 0 File Read Dataf—p
Address ns [ Write Addr ALU Memory
1 Rea 0 Write Dat
linstr[1 , Data 2 rite Lata
Write Dat
1] —-[ rite Data ]
sk s
' X Extend X ALU
16 U 32 contro
Instr[5-0]
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Load Word Instruction Data/Control Flow

\ 4

v

) Ad ,
\Ad
4 —p
PCSrc
AL Branch
MemRead
Instr[B1-26] Control MemioReg
Unit Memwvrite
\/ ALUSrc
RegWrite
RegDst
ovf
\ 4 \ 4
. IInstr25:210IRead Addr 1
Inl\s,;Itructlon Register Read —pAddress
emory lnstr(20+16}|Read Addr 2 Data 1 zero Dat
Read . ata
> Instr[31-0f=m File Read Dat >
Address "1 Write Addr ALU Memory Teac =aia
1 Rea 0 Write Dat
linstr1 , Data 2 rite Lata
Write Dat
] —-[ rite Data ]
wsh o)
' X Extend X ALU
16 U 32 contro
Instr[5-0]
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Load Word Instruction Data/Control Flow

A\ 4

: (
Ad >
\Ad
4 —p
PCSrc
AL
B h
rane MemRead
Instr[B1-26] Control MemioReg
Unit Memvvrite
\/ ALUSrc
RegWrite
RegDst
(1 oyf :
Instruction instrl2S21}Read AM
M Register Read —prAddress
emory Instr[20-16}|Read Addr 2 Data 1 zero Data I
Read ] . N
> Instr[31-0}+ 0 File Read Data
Address nstrl 1 Write Addr mea ALU Memory X
Write Data 0
linstr[1 . Data 2
1] —-[erte Data "\
Y
Unstr[15-0] \ @ \ ALU
\16 @ \32 contro
Instr[5-0]
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Branch Instruction Data/Control Flow

\ 4

v

) Ad ,
\Ad
4 —p
PCSrc
ALUO
B h
ranc MemRead
Instr[B1-2g] Control MemioReg
Unit MemWriie
\/ ALUSrc
RegWrite
RegDst
ovf
\ 4 \ 4
. IInstr25:210IRead Addr 1
Instruction Register Read —pAddress
Memory llnstr[20:16] Read Addr 2 Data 1 zZero Data
Read .
> Instr[31-0}=- File Read Dataf—p
Address ns r[3 0 Write Addr ALU Memory
1 Rea 0 Write Dat
linstr1 , Data 2 rite Lata
Write Dat
11] —i[ rite Data ]
wsh o)
' X Extend X ALU
16 U 32 contro
Instr[5-0]
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Branch Instruction Data/Control Flow

A\ 4

: {
Ad >
\Ad
4 —p
PCSrc
AL
B h
ranc MemRead
Instr[B1-26] Control MemioReg
Unit MemWrite
\/ ALUSrc
RegWrite
RegDst
ovf
A\ 4 \ 4
. Instr{25:21}|Read Addr 1
In;g:::'on Register Read —pAddress
y Instr[20-16}|Raad Addr 2 Data 1 er Data
Read .
= Instr[31-0]=- 0 File Read Dataf—p
Address ns [ Write Addr ALU Memory
1 Rea 0 Write Dat
{Instr[1 , Data 2 rite Data
Write Dat
1] —-[ rite Data ]
linstr15-9 ] 3" ALU
16 U 32 contro
Instr[5-0]
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Main Control Unit

Instr RegDst | ALUSrc | MemReg [ RegWr | MemRd | MemWr | Branch [ ALUOp1 [ ALUOp0
R-type 1 0 | O 1 | X | 0 | 0 D ¢
000000

tw 0 1 1 1 1 0| 0| 0| O
100011

W X 1 X 0 X 1 0 0 0
101011

beq X | 0| X |0 | X ] o0 | X | 1
000100

e Completely determined by the instruction opcode field

— Note that a multiplexor whose control input i1s 0 has a definite
action, even if it 1s not used in performing the operation
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Control Unit Logic

* From the truth table can design the Main Control logic

Instr[31]
Instr[30]

Instr[29]
Instr[28]
Instr[27]
Instr[26]
CXJ QO)
R-type 1w SW be
yp n 4 RegDst
. ‘)\ ALUSTrc
»
- L~ MemtoReg
. D RegWrite
r MemRead
MemWrite
» Branch
ALUOp1
ALUOpPO
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Review: Handling Jump Operations

e Jump operation have to

— replace the lower 28 bits of the PC with the lower 26 bits of the
fetched instruction shifted left by 2 bits

31 0
J-Type:| op jump target address
Ad
4 ——p
4
C >
_ Jump
Instruction address
Memory 28
N _|[Read : \
> P > Address Instruction \26
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Adding the Jump Operation

Instr[25-0] \

\ 4

v

Shift) A ~
> 26 (;eﬂ ;) 28 32 A
> PC+4[31-28] Jo
Ad > -
S Add—»|1
4 —p
Al Jump PCSrc
Branch MemRead
Instr[pji-2g] Control MemioReg
Unit Memvvriie
\/ ALUSrc
RegWrite
RegDst
ovf
A\ 4 A\ 4
. Jnstri25:21LIRead Addr 1
Inl\slsltructlon Register Read —pAddress
emory Instr[2041 Data 1 zero
L Read Addr 2 Data
Read
> Instr[31-0}== File Memory Read Datap—»
Address | |—>Wr|te Addr oo X (AR v
Data 2 Write Data
[nstri —Write Data
-1 1] -
lnstr(15-9] Mo @ Mo
16 @ 32
Instr[5-0]
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lnstr{12-9]

A

16 @ 32
Instr[5-0]

Instr[25-0] Shift M M \[
> 26 \lefty) 22 32 > 0\
PC+4[31-28] o
Ad > i’
S Add—»|1
4 —p
PCSrc
alu Jump
Branch MemRead
-26] Control MemioReg
Instr[BH Unit MemWrite
\/ ALUSrc
RegWrite
RegDst
ovf
\ 4 \ 4
. Instr25:2101Read Addr 1
In;ltructlon Register Read —pAddress
emory lInstr[20+16}|Read Addr 2 Data 1 zero Data
Read ;
> P > Instr[31-0}++ File Memory Read Data—>
Address Write Addr g 5 ALU
Write Data
Data 2
'”3“[11 § [{Write Data
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Single Cycle Implementation Cycle Time

Unfortunately, though simple, the single cycle approach i1s
not used because it 1s inefficient

Clock cycle must have the same length for every instruction

What 1s the longest path (slowest instruction)?
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Instruction Critical Paths

0 Calculate cycle time assuming negligible delays (for
muxes, control unit, sign extend, PC access, shift left 2,

wires) except:
e Instruction and Data Memory (2ns)
e ALU and adders (2ns)
e Register File access (reads or writes) (1ns)

Instr. IMem | RegRd | ALUOp | DMem | Reg Wr Total

R-type

load

store

beq

jump
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Where We are Headed

Problems with single cycle datapath design
— uses clock cycle inefficiently

— and what if we had a more complicated instruction like floating point
multiply?

— wasteful of area
Another approach
— use a “smaller” cycle time
— have different instructions take different numbers of cycles
— a “multicycle” datapath:

y

\ 4

C e 1 a]
ALuoud

v

oLy 1, Memory I —>Read Addr 1
o Address

Register Rea
Read Dat

Read Addr Data 1
(Instr. or Data = \\rite Addr

File
r Write Data

CALU

Rea
»|Write Data Data 2

| MDR |

David Brooks — CS141



